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Warranty and liability

Note The Application Examples are not binding and do not claim to be complete
regarding the circuits shown, equipping and any eventuality. The Application
Examples do not represent customer-specific solutions. They are only intended
to provide support for typical applications. You are responsible for ensuring that
the described products are used correctly. These application examples do not
relieve you of the responsibility to use safe practices in application, installation,
operation and maintenance. When using these Application Examples, you
recognize that we cannot be made liable for any damage/claims beyond the
liability clause described. We reserve the right to make changes to these
Application Examples at any time without prior notice.
If there are any deviations between the recommendations provided in these
application examples and other Siemens publications – e.g. Catalogs – the
contents of the other documents have priority.

We do not accept any liability for the information contained in this document.

Any claims against us – based on whatever legal reason – resulting from the use of
the examples, information, programs, engineering and performance data etc.,
described in this Application Example shall be excluded. Such an exclusion shall
not apply in the case of mandatory liability, e.g. under the German Product Liability
Act (“Produkthaftungsgesetz”), in case of intent, gross negligence, or injury of life,
body or health, guarantee for the quality of a product, fraudulent concealment of a
deficiency or breach of a condition which goes to the root of the contract
(“wesentliche Vertragspflichten”). The damages for a breach of a substantial
contractual obligation are, however, limited to the foreseeable damage, typical for
the type of contract, except in the event of intent or gross negligence or injury to
life, body or health. The above provisions do not imply a change of the burden of
proof to your detriment.

Any form of duplication or distribution of these Application Examples or excerpts
hereof is prohibited without the expressed consent of the Siemens AG.

Security
informa-
tion

Siemens provides products and solutions with industrial security functions that
support the secure operation of plants, solutions, machines, equipment and/or
networks. They are important components in a holistic industrial security
concept. With this in mind, Siemens’ products and solutions undergo continuous
development. Siemens recommends strongly that you regularly check for
product updates.

For the secure operation of Siemens products and solutions, it is necessary to
take suitable preventive action (e.g. cell protection concept) and integrate each
component into a holistic, state-of-the-art industrial security concept.  Third-party
products that may be in use should also be considered.  For more information
about industrial security, visit http://www.siemens.com/industrialsecurity.

To stay informed about product updates as they occur, sign up for a product-
specific newsletter. For more information, visit
http://support.industry.siemens.com.

http://www.siemens.com/industrialsecurity
http://support.industry.siemens.com/
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Preface
Introduction

There are various automation systems available for the SIMATIC PCS 7 process
control system which differ in performance, quantity structure, communications
interfaces and scalability, among other things. These include:
 AS 410 automation systems
 Complementary S7-400 systems (AS 412 to AS 417)

Depending on the automation performance requirements, CPU 412 to CPU 417
may be used on the complementary S7-400 systems. If the performance limit of
one of the CPUs being used is reached, e.g., as a result of necessary modifications
to the user program, the hardware must be exchanged to increase the
performance, or a higher performance S7-400 system used.
The AS 410 offers a CPU - the innovative CPU 410-5H - which is versatile in use.
The automation performance is scaled without having to change the CPU and is
effected by means of the number of PCS 7 process objects. In this case the best
performance is always available regardless of the area of application.
The reduction of types on the AS 410 to a single CPU brings numerous benefits.
It simplifies considerably the selection, configuration and planning of the
automation system, as well as replacement parts holding and plant expansion.

Document contents
In this document, scenarios are described which explain relevant functions of the
CPU 410-5H Process Automation in the AS 410 and illustrate advantages over the
complementary S7-400 systems. Additionally you will gain an overview of important
configuration steps and hints.
You will find information on the following topics in the document:
 General information on the CPU 410-5H Process Automation
 Advantages of the CPU 410-H
 Configuring the communications interface and establishing the connection

between the ES and the AS
 Type Change in RUN (TCiR) function
 Configuration of the PN/Ethernet interfaces
 Online upgrade of process objects

Applicability
This application applies to:
 CPU 410-5H Process Automation, Firmware Version 8.1
 SIMATIC PCS 7 V8.1
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1 CPU 410-5H at a glance
In this chapter you will find general information on the CPU 410-5H, its functions
and areas of application.

1.1 Introduction

The CPU 410-5H is a controller specially designed for process automation which
is versatile in use. With its robust, high performance hardware, the CPU 410-5H
covers the entire performance spectrum of the AS 412 to AS 417 complementary
systems.

Scalable performance
The performance range of the CPU 410-5H can be individually scaled according
to the size and type of the PCS 7 applications. This is done by means of the PO
volume, which is determined by the System Expansion Card (SEC). The volume
extends from 100 PO to unlimited, at which point other performance data of the
CPU act as the limiting factor.
The PO quantity structure of an SEC can be conveniently extended from the PCS 7
V8.1 by means of CPU 410 expansion packs. It is not necessary to dismantle the
CPU or the SEC. There are CPU 410 expansion packs available for 100 POs and
500 POs. You have the following options when ordering CPU 410 expansion
packs:
 Online via http://www.siemens.com/industrymall
 Through your Siemens contact person (www.siemens.com/automation/partner)

Communications
The CPU has two 10/100 MBit/s PN/Ethernet interfaces, which can be configured
as follows:
 2x PROFINET, e.g., for redundant configurations without the use of external

CPs
 1x Industrial Ethernet and 1x PROFINET, e.g., for connecting to the plant bus

and the process bus without the use of external CPs.
 2x Industrial Ethernet, e.g., to design redundancy into the plant bus

Additionally, the CPU has a 12 MBit/s PROFIBUS interface and allows the
connection of up to 96 nodes. The distributed process I/O can be linked either
directly (PROFIBUS DP) or via a subordinate process bus (PROFIBUS PA).

http://www.siemens.com/industrymall
http://www.siemens.com/automation/partner
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The PROFINET interfaces can be used for connecting or expanding the I/O
devices. 250 devices can be connected for each PROFINET interface.

Process safety functions
The SIMATIC PCS 7 CPU 410 is set up as standard for integrated process safety
functions and offers all the functions required for safety-oriented applications. The
controller is TÜV certified and meets all safety requirements up to SIL 3. The CPU
is capable of multitasking, meaning that several programs can run simultaneously -
both Basic Process Control Applications (BPCS) and safety-oriented applications.
The programs are also reaction-free, with the result that potential errors in the
BPCS applications have no effect on the safety-oriented applications and vice
versa.

Fault tolerance
Two redundant, galvanically isolated controllers are used to guarantee maximum
availability. They can be mounted on a common rack or also operated
synchronously at a distance of up to ten kilometers from one another. In this case,
one of the two CPUs functions as the master and the other as the reserve. In each
case two synchronization submodules are used for redundant coupling, the two
CPUs being synchronized by means of fiber-optic cables. The modules can be
exchanged during operation.
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1.2 Advantages of the CPU 410-5H

General
The CPU 410-5H offers, among others, the following advantages:
 A hardware platform for all application uses, application sizes and performance

ranges
Consequently the selection, configuration and planning of the automation
system are simplified.

 Lower costs for spare or replacement part inventories, as only one CPU type is
used in the project.

 Flexible expansion of the automation performance without replacing hardware
 Lower investment costs and greater possibilities for use in regions with coating

requirements, due to the protective coating of the CPU 410-5H
 Reduction of plant downtime due to the possibility of type updating of AS

blocks in RUN mode (TCiR).

Plant planning
The advantages of the CPU 410-5H come into their own above all when planning
a new plant:
 When planning the automation performance necessary for your plant, you will

no longer have to consider different CPU variants, as the CPU 410-5H can be
used for all purposes (e.g. as an H or an F system, as well as for all application
sizes).

 The required automation performance (PO volumes) can be ordered according
to the application size after the engineering phase is complete.

 The automation performance can be conveniently expanded as required at
any time by means of the CPU System Expansion Card (SEC), without any
exchange of hardware or plant downtime.

 The planning of the CPU spares is simplified considerably by the use of
standardized hardware. In this case you will only need one CPU 410-5H
without SEC as a replacement part, since the SEC can be transferred if the
CPU is exchanged.

 Due to networking with PROFINET (PN), switchgear and drives can be
reached by every CPU without expensive cabling. Should program relocations
to another CPU arise in the course of the implementation, it will not be
necessary to rewire the station or the device.

Note The PN communication which spans the CPUs can influence the performance
capability of all the CPUs in the PN network.
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2 Application scenarios
2.1 Configuring the communications interface and

establishing the connection between the ES and
the AS

In order to implement the application scenarios described in this chapter,
a connection must be set up between the Engineering Station (ES) and the
Automation System. The configuration procedure depends on the communications
interface used. A distinction is made between:
 As with additional CP
 Internal PN/Ethernet interfaces of the CPU

2.1.1 Establishing a connection using an additional CP in the AS

The following will describe how to establish a connection between ES and AS
using the CP 443-1.

Requirement
In order to establish a connection between the ES and the AS (via the CP),
the modules must be fitted in the rack as shown in the operating manual.

Preliminary considerations
Before establishing communication, you must define whether you want to use
TCP/IP or ISO. The addressing (IP address, MAC address) is carried out on
the basis of the interface selection.
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Connection via ISO interface
The following points are a step-by-step description of how to establish the
connection between the AS and the ES.
1. Configure the AS in the HW Config and assign the address for the CP (MAC

address) accordingly.

2. Save and compile the configuration.
3. From the menu command "Tools > Set PG/PC station..." in the SIMATIC

Manager, set the "Interface parameter setting used" to "ISO" (e.g.,
CP1623.ISO.1).

4. Switch back to the HW Config.
5. Execute the menu command "Target system > Load in module...".
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6. In the "Select Target Module" dialog window, select the relevant module and
click on "OK".
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7. If you have not changed the MAC address for the CP (configured MAC
address is the same as the factory-set MAC address), click on the "OK" button
in the "Select Node Address" dialog window.
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If you have configured a different MAC address, then click on the "View" button.
Then in the "Accessible Nodes" box, select the CP from which you want to load
the configuration. Now click on the "OK" button.

8. The configuration has now been loaded into the AS.

Note After an address change, always load the configuration via the HW Config or
NetPro. The accessible nodes to which you can make assignments by loading
a new address are only shown here. When loading from the SIMATIC Manager,
an attempt will be made to load via the configured address. Since this cannot be
accessed, the loading procedure will be aborted, accompanied by an appropriate
message.
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Connection via TCP/IP interface
The following points are a step-by-step description of how to establish the
connection between the AS and the ES.
1. Configure the AS in the HW Config. and assign the IP parameters for the CP

(IP address, subnet mask) accordingly.

1. Save and compile the configuration.
2. From the menu command "Tools > Set PG/PC station..." in the SIMATIC

Manager, set the "Interface parameter setting used" to "RFC1006" or "TCPIP"
(e.g., CP1623.RFC1006.1).

3. Switch back to the HW Config.
4. Execute the menu command "Target system > Edit Ethernet Node".
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5. Click on the "Browse" button in the "Edit Ethernet Node" dialog window.
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6. In the "Browse Network" dialog window, select the CP by means of the MAC
address and click on the "OK" button.

Note If not all or none of the connected nodes are displayed, check the settings for
the network components used (switches,...).
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7. The MAC address and the IP parameters for the CP are entered in the "Edit
Ethernet Node" dialog window. Adapt the IP parameters according to your
configuration in HW Config (see Step 1). Next click on the "Assign IP
Configuration" button and then on the "Close" button.

Note If you start the search again, you can check to see if the parameters have been
correctly accepted.
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8. Execute the menu command "Target system > Load in module...".
9. In the "Select Target Module" dialog window, select the relevant module and

click on "OK".
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10. In the "Enter connection to target station" box in the "Select Node Address"
dialog window, select the relevant IP address and click on the "OK" button.

11. The configuration has now been loaded into the AS.
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2.1.2 Establishing a connection via internal PN/Ethernet interfaces of the
CPU

The following describes how to establish a connection between the ES and the AS
using the internal PN/Ethernet interfaces of the CPU 410-5H.

Requirement
In order to establish a connection between the ES and the AS using the internal
interfaces of the CPU 410-5H, the CPU 410-5H must be fitted in the rack as shown
in the operating manual and be connected to the ES via the network (Ethernet).

Preliminary consideration
Before configuring, define which interface is to be used to connect the CPU to the
plant bus. An IP address from the address range of the plant bus must be used for
the interface.

Note The ISO protocol is not supported by the internal PN/Ethernet interfaces.
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Connection via PN/Ethernet interface
The following points are a step-by-step description of how to establish the initial
connection between the CPU 410-5H and the ES.
1. Configure the AS in the HW Config and assign the IP parameters (IP address,

subnet mask) in the PN/Ethernet interface.

2. Save and compile the configuration.
3. From the menu command "Tools > Set PG/PC station..." in the SIMATIC

Manager, set the "Interface parameter setting used" to "RFC1006" or "TCPIP"
(e.g., CP1623.RFC1006.1).

4. Switch to the HW Config.
5. Execute the menu command "Target system > Edit Ethernet Node".
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6. Click on the "Browse" button in the "Edit Ethernet Node" dialog window.
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7. In the "Browse Network" dialog window, select the CPU by means of the MAC
address and click on the "OK" button.

Note If not all or none of the connected nodes are displayed, check the settings for the
network components used (switches,...).
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8. The MAC address and the IP parameters for the Ethernet interface are entered
in the "Edit Ethernet Node" dialog window. Adapt the IP parameters according
to your configuration in HW Config (see Step 1). Next click on the "Assign IP
Configuration" button and then on the "Close" button.

Note If you start the search again, you can check to see if the parameters have been
correctly accepted.
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9. Execute the menu command "Target system > Load in module...".
10. In the "Select Target Module" dialog window, select the relevant module and

click on "OK".
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11. In the "Enter connection to target station" box in the "Select Node Address"
dialog window, select the relevant IP address and click on the "OK" button.

12. The configuration has now been loaded into the AS.
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2.2 Loading interface changes from AS blocks in RUN
mode (TCiR)

Introduction
The CPU 410-5H V8.1 supports type updating with interface changes in RUN
mode (Type Change in RUN (TCiR)). It is thus possible to update the instances
after an interface change to block types and load them into the target system in
RUN mode. With the TCiR function you can, for example, also update a library
without having to put the CPU in the STOP state.

NOTICE The following changes to the block can only be loaded in the STOP mode:

 Changed default value of a connection
 Changed name of an input with configured message ("Message Event ID")

This chapter will describe as an example, how to add a new connection to the
block and then load this change into the CPU 410-5H in RUN mode.

Requirement
The following requirements apply:
 A PCS 7 multiproject is open in the SIMATIC Manager.
 The automation program has been compiled and loaded into the CPU 410-5H.

Making interface changes
Open the standard library for the project in the component view.
1. Open the "Sources" folder.
2. Open the SCL source for the desired block type.
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3. Carry out the desired changes.
In this example, the connection "LOCK_2" will be added for an additional
interlock on the block.

4. Save the changes and compile the SCL program.
5. Close the SCL source.
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Loading interface changes in RUN mode
1. Select the "Blocks" folder in the standard library.
2. Execute the command "Extras > Charts > Update block types".

The "Update block types" dialog will open.
3. Check the check box in the "Download in RUN" column and click on the

"Calculate" button in the "Resources" column.

The "Resource information" dialog opens. This contains information about resource
requirements for type changing in the automation system in which the type change
will be made.
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4. Close the "Resource information" dialog.
5. Click on the "Continue" button in the "Update block types" dialog.

In this step, the display will show whether the type change can be carried out
in the RUN state on the basis of the calculation in the "Consequence" field.

6. Click "Finish". Wait until the updating procedure has successfully completed.
A log file is displayed at the end of the procedure.

7. Select the "Charts" folder for the AS program and open a CFC chart.
The message "TCiR: Download required!" will be displayed in the status bar.
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8. Click on the "Download" button in the toolbar.
The "Compile program / Download to target system" dialog will open.

9. Check the "Entire program" option in the "Compile charts as program" tab.

10. Open the "S7 download" tab and check the "Changes only" option.

11. Click on the "OK" button.
The interface changes will be downloaded into the CPU 410-5H in RUN mode.
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2.3 Configuring the PN/Ethernet interfaces of the
CPU 410-5H

In this chapter you will find information about configuration options for the
PN/Ethernet interfaces of the CPU 410-5H.

2.3.1 Configuring the interfaces for connection to the plant bus and the
process bus without using an external CP

Due to its two PN/Ethernet interfaces, the CPU 410-5H can provide the option of
implementing a connection to the plant bus and the process bus without using an
external CP. This yields the following benefits:
 Reduction of hardware costs
 More space due to the use of compact mounting racks

The configuration procedure is carried out in the following steps:
 Expand the project by one new AS station
 Configure the interface for the plant bus
 Configure the interface for the process bus

The following figure shows the configuration schematically:
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Requirements
The following requirements must be met:
 There is a PCS 7 multiproject present.
 A CPU 410-5H is connected.

Expand the project by one new AS station
1. Open a PCS 7 multiproject in the SIMATIC Manager.
2. Insert a new sub-project using the "File > New project" command.
3. Click on the sub-project with the right mouse button and select the "Insert new

object > Preconfigured station“ command from the context menu.
The "PCS 7 Wizard: Expand project" dialog will open.

4. Select the CPU 410-5H without CP and insert the station. In this example,
the procedure will be explained using the example of a single station (AS410-
Single (1H)).

5. Open the AS station with the CPU 410-5H in HW Config.

Configure the interface for the plant bus
1. Open the properties for the "PN-IO-X5" interface of the CPU 410-5H in

HW Config.
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2. Enter a device name in the "General" tab.

3. Click on the "Properties..." button
4. Enter a valid IP address and subnet mask for the plant bus.
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5. Assign an existing subnet to the interface or create a new subnet for it. In this
example, a new subnet will be created for the plant bus and assigned to the
interface.

6. Confirm the settings with the "OK" button.
The interface will be connected to the plant bus.
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Configure the interface for the process bus
1. Open the properties for the "PN-IO-X8" interface of the CPU 410-5H in the

HW Config.
2. Select the "PN-IO-X8" interface with the right mouse button and select the

"Insert PROFINET IO system" command from the context menu.

The "Properties..." dialog will open.

3. Enter a valid IP address and subnet mask for the process bus.
4. Assign an existing subnet to the interface or create a new subnet for it. In this

example, a new subnet will be created for the process bus and assigned to
the interface.
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5. Confirm the settings with the "OK" button.
A PROFINET IO system for connecting the PROFINET IO modules will be
created.

Further information on planning the PROFINET interface can be found in the
application example "SIMATIC PCS 7 with PROFINET – Typical Configurations"
(Chapter 4, "Configuration, Planning and Parameter Setting").

http://support.automation.siemens.com/WW/view/en/72887082
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2.3.2 Configuring two separate PROFINET interfaces for connection to the
process bus

When there is a large number of devices, the CPU 410-5 offers the option of
configuring two PROFINET interfaces for connection to the process bus.
In this case, the connection to the plant bus is made via an external CP.
The configuration procedure is carried out in the following steps:
 Expand the project by one new AS station
 Configure the CP interface for the plant bus
 Configure two PROFINET interfaces for the process bus

The following figure shows the configuration schematically:

Requirements
The following requirements must be met:
 There is a PCS 7 multiproject present.
 A CPU 410-5H is connected.
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Expand the project by one new AS station
Proceed as follows to configure two PROFINET interfaces for the process bus:
1. Open a PCS 7 multiproject in the SIMATIC Manager.
2. Insert a new sub-project using the "File > New project" command.
3. Click on the sub-project with the right mouse button and select the "Insert new

object > Preconfigured station“ command from the context menu.
The "PCS 7 Wizard: Expand project" dialog will open.

4. Select the CPU 410-5H with a CP and insert the station. In this example,
the procedure will be explained using the example of a single station (AS410-
Single (1H)) with a CP 443-1.

Configure the CP interface for the plant bus
1. Open the AS station with the CPU 410-5H in the HW Config.
2. Open the properties for the "PN-IO" interface of the CP 443-1.
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3. Open the "General" tab and enter a meaningful device name.

4. Click on the "Properties..." button
5. Enter a valid IP address and subnet mask for the plant bus.
6. Assign an existing subnet to the interface or create a new subnet for it.

7. Confirm the settings with the "OK" button.
The CP443-1 interface will be connected to the plant bus.
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Configure the PROFINET interfaces for the process bus
1. Open the HW Config.
2. Open the properties for the "PN-IO-X5" interface of the CPU 410-5H in the

HW Config.
3. Select the "PN-IO-X5" interface with the right mouse button and select the

"Insert PROFINET IO system" command from the context menu.
The "Properties" dialog for the interfaces will open.

4. Enter a valid IP address and subnet mask.
5. Assign an existing subnet to the interface or create a new subnet for it. In this

example, a new subnet ("Processbus_AS02_1") will be created for the process
bus and assigned to the interface.
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6. Confirm the settings with the "OK" button.
The PROFINET IO system "Processbus_AS02_1" will be assigned to the
interface.
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7. Select the "PN-IO-X8" interface with the right mouse button and select
the "Insert PROFINET IO system" command from the context menu.
The "Properties" dialog for the interfaces will open.

8. Enter a valid IP address and subnet mask.
9. Assign an existing subnet to the interface or create a new subnet for it. In this

example, a new subnet ("Processbus_AS02_2") will be created for the process
bus and assigned to the interface.
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10. Confirm the settings with the "OK" button.
The PROFINET IO system "Processbus_AS02_2" will be assigned to the
interface.

Further information on planning the PROFINET interface can be found in the
application example "SIMATIC PCS 7 with PROFINET – Typical Configurations"
(Chapter 4, "Configuration, Planning and Parameter Setting").

http://support.automation.siemens.com/WW/view/en/72887082
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2.4 Online upgrade of CPU 410-5H process objects

2.4.1 Introduction

When you load a PCS 7 project into the CPU, the system checks that the project
can run with the current number of process objects (PO) in the CPU.
If the number is not sufficient, starting with PCS 7 V8.1 you have the option of
increasing the PO volume by means of an online upgrade of the CPU 410-5H
system expansion card (SEC).

CPU 410 expansion packs
You will need at least one CPU 410 expansion pack for the online upgrade of
the process objects of a CPU 410-5H.
The CPU expansion packs are available in the following sizes:
 100 PO
 500 PO

The expansion packs can be combined in any way up to the maximum size.
However note that with a redundant system (2 CPUs), the CPU 410 expansion
packs must be distributed symmetrically between the CPUs.
The volume of a CPU expansion pack must always be assigned in its entirety to
a CPU or SEC of the CPU. Distribution between several CPUs or SECs is not
possible.
After a PO upgrade, the POs that are assigned to an SEC/CPU can no longer be
relocated.

Example
If the number of POs in the CPU is not sufficient to load the engineering project,
you can increase the PO volume of the CPU by means of an online upgrade.

Table 2–1

Expansion by 300 PO (from 400 PO to 700 PO)

With a single AS, to increase the number of POs
by 300 you require 3 CPU 410 expansion packs,
each with 100 POs.
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Expansion by 300 PO (from 400 PO to 700 PO)

With a redundant AS (2 CPUs), to increase the
number of POs by 300 you require 6 CPU 410
expansion packs, each with 100 POs. This is required
since both CPUs must be expanded by 300 POs.
In this case you cannot combine expansion packs
with 500 PO and 100 PO, since the PO volume of
an expansion pack cannot be subdivided.

The following table contains further examples:
Table 2–2

PO expansion
by

CPU 410 expansion packs required

Single AS Redundant AS

400 PO 4  x 100 PO 8  x 100 PO
500 PO 1 x 500 PO or

5  x 100 PO
2 x 500 PO or
10  x 100 PO

600 PO 1 x 500 PO + 1 x 100 PO or
6  x 100 PO

2 x 500 PO + 2 x 100 PO or
12  x 100 PO

1000 PO 2 x 500 PO or
10  x 100 PO

4 x 500 PO or
20  x 100 PO
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2.4.2 Overview of the steps

The online upgrade is carried out in the following main steps:
Table 2–3

Schematic representation Step

1. Order the CPU 410 expansion packs.

2. In the SIMATIC Automation License Manager
(ALM), transfer the CPU 410 expansion packs
to the CPU and create a PO activation file.

3. Send the PO activation file for checking and
activation by means of a support request.

Within 48 hours you will receive by e-mail a PO
release file (for each PO activation file sent) as
confirmation of the checking.

4. Transfer the PO release file to the SEC of the
CPU using the ALM.

NOTICE When performing an online upgrade of the process objects, pay attention to the
information and notes in the manual "SIMATIC PCS 7 Service Support and
Diagnostics (V8.1)".
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2.4.3 Order the CPU 410 expansion packs

You have the following options when ordering CPU 410 expansion packs:
 Through your Siemens contact person (www.siemens.com/automation/partner)
 Online via www.siemens.com/industrymall

After you have received the CPU 410 expansion packs (by e-mail or USB stick),
transfer them to a disk drive that can be accessed by the Engineering Station.

C:///%5C%5CUsers%5C%5Crene.scharoba%5C%5CDesktop%5C%5C10200-139_Siemens%5C%5C05-an_Layout%5C%5Cwww.siemens.com%5C%5Cautomation%5C%5Cpartner
http://www.siemens.com/industrymall
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2.4.4 Create the PO activation file using the Automation License Manager
(ALM)

1. Store the CPU 410 expansion packs on a drive that can be accessed in the
Automation License Manager (ALM).

2. Select the menu command "Edit > Connect target system >
Connect/disconnect AS 410...".

The "Connect Target System" dialog opens.
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3. Click on the "Add" button to establish an on-line connection to a CPU 410-5H.

4. In the PCS 7 project, select the CPU to which you wish to transfer the
CPU 410 expansion packs or PO. Then click on the "OK" button.

The CPU will be displayed in the ALM.
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5. Drag the license keys for the CPU 410 expansion packs and drop them on
to the automation system for which you wish to perform the PO upgrade.

Note If you have selected the wrong automation system, you can move the license
keys for the CPU 410 expansion packs using drag and drop.
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6. Open the "Online" folder in the tree view for the automation system.
7. Select the license and then select the "License Key > Upgrade" menu

command.

NOTICE When you initiate the upgrade, the selected CPU 410 expansion packs will be
assigned to the SEC. Moving to another AS will no longer be possible.

The license keys for the selected CPU 410 expansion packs will be deleted and
a PO activation file will be created in the "Your document > Siemens >
Automation > PCS 7 > Activations" folder.
The ALM will indicate that the PO activation file contains a volume expansion
(in this example, from 600 to 700).
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2.4.5 Send the PO activation file via Support Request

1. Start a support request via the following web page:
http://www.siemens.com/automation/support-request.

2. "Select product" step:
– Enter "CPU 410" in the "Product/Order number" text box and click on the

"Search" button.
– Check the "Authorization > CPU 410 Activation File" radio button.
– Check the "Problem with the authorization/license" check box and then

click on the "Next" button.

http://www.siemens.com/automation/support-request
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3. "Select application" step: Enter "Upgrade CPU 410" in the text box and click on
"Next".

4. "Our solutions" step: Click on the "Next" button.
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5. "Describe the problem" step:
– Make the entries in the mandatory fields.
– Enter the text "Request PO activation file" in the "Details" text box.
– Insert the PO activation file as a Zip file using the "Choose File" button.

Note PO activation files are automatically created in the following Upgrade directory
in the Engineering Station:

"Your documents > Siemens > Automation > PCS7 > Activations"

Note You can send several PO activation files with one support request.

– Click on the "Next" button.

6. "Specify contact data" step: Specify your contact data, then click on the "Next"
button.

7. "Summary and send" step: Check your details, then click on the "Send" button.
Within 48 hours you will receive an e-mail containing a PO release file for each
PO activation file sent.
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2.4.6 Transfer the PO release file to the SEC of the CPU

1. Transfer the PO release files received to the Upgrade directory in the
Engineering Station:
"Your documents > Siemens > Automation > PCS7 > Activations".

2. Open the menu command Automation License Manager (ALM).
The automation systems that are connected to the Automation License
Manager are shown in the list in the "Connect AS 410" dialog box.

3. Click on the "Add" button to connect a further automation system. In the PCS 7
project, select the CPU to which you wish to transfer the PO release file. Then
click on the "OK" button.

The CPU will be displayed in the ALM.
1. Drag the PO release file and drop it on to the "Online" folder of the desired

automation system.

The upgrade will be carried out. The time taken depends on the loading of the
automation system.
After an upgrade is completed, the files used in the Upgrade directory will be
deleted (PO release file and PO activation file).
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The Automation License Manager shows the new number of POs for the updated
SEC.

Note You can also call up the volume of the SEC, as well as the process objects that
are subject to license, in the SIMATIC Manager at "Extras > PCS 7 license
information".

2.5 Additional information

2.5.1 Replacing an existing CPU with the CPU 410-5H

An existing CPU in the S7-400 series can be replaced by the CPU 410-5H with
little effort. In addition to the hardware exchange, some adaptations must also be
made to the hardware configuration of the PCS 7 project. You will find extensive
information about this at
https://support.industry.siemens.com/cs/ww/en/view/85014617.

2.5.2 Extending availability

With the standard SIMATIC PCS 7 AS 410 automation system, you already have
the option of selectively increasing the availability by means of redundant
configuration of the Industrial Ethernet communications module.
With its redundant CPUs, the Type AS 410H redundancy station offers
considerably greater availability. It works on the 1 of 2 principle, where the reserve
system is switched in if there is a failure of the active subsystem. In the same way,
you can also double up the power supply or the Industrial Ethernet communications
modules for each subsystem and combine these measures with one another.
You can find extensive information about the procedure for expanding a Single
Station to a Redundancy Station at
https://support.industry.siemens.com/cs/ww/en/view/82523363.

https://support.industry.siemens.com/cs/ww/en/view/85014617
https://support.industry.siemens.com/cs/ww/en/view/82523363
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3 Related literature

Table 3-1

Topic Title / Link

\1\ Siemens Industry Online Support http://support.industry.siemens.com

\2\ Download page of this entry https://support.industry.siemens.com/cs/ww/en/
view/96839331

\3\ SIMATIC PCS 7 process control
system CPU 410-5H Process
Automation

https://support.industry.siemens.com/cs/ww/en/
view/74736822

\4\ SIMATIC Process Control System
PCS 7 Service support and
diagnostics (V8.1)

https://support.industry.siemens.com/cs/ww/en/
view/90682682

4 History

Table 4–1

Version Date Change

V1.0 10/2014 First edition
V1.1 12/2014 Reworking of Section 3.1 Loading interface changes from

AS blocks in RUN mode (TCiR)
V1.2 03/2015  New Section 3.1 Configuring the communications

interface and establishing the connection between the
ES and the AS

 Reworking of Section 3.4 Online upgrade of CPU 410-
5H process objects

V1.3 06/2015 Reworking of Section 2.4.5 Send the PO activation file
via Support Request

http://support.industry.siemens.com/
https://support.industry.siemens.com/cs/ww/en/view/96839331
https://support.industry.siemens.com/cs/ww/en/view/96839331
https://support.industry.siemens.com/cs/ww/en/view/74736822
https://support.industry.siemens.com/cs/ww/en/view/74736822
https://support.industry.siemens.com/cs/ww/en/view/90682682
https://support.industry.siemens.com/cs/ww/en/view/90682682
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